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1. INSTALLATION 

1.1. REQUIREMENTS 

In order to ensure that the application functions correctly, the user should have system 

hardware which is suitable for viewing stereo images, such as application support software 

(operating system and drivers). 

Hardware requirements 

 Dual Core 2 GHz processor or better. 

 2 Gigabytes RAM memory or more. 

 DVD reader. 

 Normal graphics card, with 256 MB and support for OpenGL 1.0 or NVidia Quadro FX 256 

MB graphics card or better, in order to see models on other supported stereo systems. 

 Stereo vision system compatible with the graphics card: 

- Active stereo through NVidia 3D Vision type LC shutter glasses and monitor. 

- Active stereo through NuVision type CRT shutter glasses and monitor. 

- Passive stereo through Zalman Trimon type horizontal polarization monitor. 

- Passive stereo through LCD monitors and Planar type polarizing mirror. 

- Passive stereo through anaglyph glasses (color filters). 

Software requirements 

 Microsoft Windows 32-bit XP or Vista operating system with all the latest updates. 

 Microsoft VC++ 2008 and 2010 Runtime  and Microsoft .NET framework v4.0  

 CAD design software: 

AutoCAD 2004 to 2007. 

AutoCAD 2008 to 2015 (32 or 64 bits). 

Bricscad v9 to v15. 

 Updated drivers for the graphics card used. 

Note: You may obtain further information on the different stereo vision systems by visiting 

the websites of the respective manufacturers. 
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1.2. INSTALLATION PROCESS 

Insert the installation DVD into the corresponding drive - the installation program will start up 

automatically. If it does not start, run file X:\setup.exe, where X = DVD drive. 

The conventional installation process for the various Windows platform programs will be 

executed immediately. You will need to have administrator privileges in order to install the 

programme. You will initially need to have the application's pre-requisite software installed: 

1. Microsoft .NET Framework 4.0. 

2. Microsoft Visual C++ Runtime 2008 and 2010. 

Read the license carefully. In the event that you do not accept the term contained therein, 

cancel the process and return the program to the distributor. 

 
Figure 1 – Installation: License of use. 

Insert your name and company, select the folder in which you wish to install the program and 

set the users shall use the application. It is recommended that you have a hard disc with 

space enough (gigabytes) if you want to install examples and create new projects. 
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Figure 2 – Installation: application folder  selection. 

Once the process has finished, the installer will copy the necessary files and create the 

elements required for your system. 

 
Figure 3 – Installation: finishing the process. 

Once the program has been installed, it is advisable to reboot the computer in order to 

ensure that the changes you have made come into effect. 
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1.3. POST-INSTALLATION 

Installing the Protection Key 

Inserting the Protection Key (USB) 
Once the application has been installed, connect the USB key to any free USB port on your 
PC. The system will recognize the key automatically. If it does not, consult the support 
document. 

Tutorial 

Make use of the examples included on the installation DVD - practice with them, learn how 

TcpStereo works in order to get maximum benefit from its functions. These examples may 

also be downloaded from our website (www.aplitop.com); they are, however, lower resolution 

images to reduce download size. 

In the Users Manual there is a quick guide that shows how to open and import projects, 

based on these examples, which can be used as a tutorial. 

Customization 

In Section 4 of this manual you will find all the information you need in order to customize 

various aspects of the application, allowing you to adapt it better to your personal 

preferences and way of working.  

1.4. TROUBLESHOOTING 

The installation program automatically installs the drivers needed for the proper running of 
the program's protection. Only if a network license is acquired is necessary to carry out some 
further operations after the program has been installed. 

If, on starting up the program, you see the message "ERROR: Hardlock not found" or 
similar, it may be the case that the protection drivers have not been installed properly. To 
ensure correct installation, run the setup.exe file in the drivers\sentinel folder of the 
program DVD. Once the installation has been completed, reboot the computer. 

In order to solve other problems that might arise during the installation or use of the software, 
there is product support information on our website. 

  

http://www.aplitop.com/
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2. CONCEPTS AND DEFINITIONS 

In order to understand how the program works, we should explain certain concepts relating to 

aerial photogrammetry, given that the application is based on these concepts. 

2.1. IMAGE 

The images are the aerial photographs taken during photogrammetric flights. Each image is 

contained on an image file in a specific format. The image file format used by the program is 

TIFF (Tagged Image File Format), usually used for digital photographs and scanned 

analogue photos. 

If the image format is other than TIFF, you may convert them to this format using an image 

editing program. 

2.2. INTERNAL AND EXTERNAL ORIENTATION 

In order to be able to use an image, its internal and external orientations need to be known. 

The internal orientation consists of a set of parameters that allow us to transform image file 

pixels to the real physical dimensions (in millimeters) of the photograph and vice-versa. 

These parameters are principally deduced from the camera characteristics, such as the focal 

distance, the principal point, the physical dimensions of the photograph, and certain lens 

distortion values. Additionally other flight characteristics are used, such as flight height and 

terrain. 

The internal orientation of digital images is obtained through metadata contained in the 

corresponding image files. 

The external orientation determines the exact position and orientation of the camera at the 

precise moment that the photograph was taken. It consists of three-dimensional coordinates 

X, Y and Z, referred to as the photo-center, and three rotations Ω, Φ and Κ (with respect to 

XYZ axes), with Ω and Φ values usually close to zero. 

External orientation tends to come in a flat text file (ASCII) where for each photograph there 

is a line of form: 

Nº Photograph  X Y Z Ω Φ Κ 

The order of the fields might vary, or the field separator may not be the tabulator. More fields 

may also appear in these lines with additional information. In any event, the photograph 

number must always be present, as must the photo-center coordinates and the three angles 

of rotation. 

2.3. MODEL 

A model or stereoscopic pair is simply a pair of consecutive and oriented images which share 

a common area known as the overlap. This overlap is what allows the image to be seen in 

stereo, as it shows the same area seen from two distinct points. External orientations 

determine the way in which these images align at each point of the overlap. 
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2.4. STRIP 

A strip can be defined as a set of consecutive photographs. We can also see a set of 

consecutive models where an image is a part of two consecutive models. The external 

orientations of the images determine the direction of the strip. 

2.5. PHOTOGRAMMETRIC BLOCK 

It should be remembered that in order to cover a section of terrain, a number of strips may be 

required to ensure that the set of images completely covers the area of interest. A block is 

the strip or group of strips that cover the area of interest in question. For small projects the 

block may consist of only one or two strips, with just a few images per strip, whilst large 

projects may require a number of strips with each consisting of considerably more images. 

Generally, photogrammetric blocks are shown in rectangular form, with the strips arranged in 

lines. 

The strips in a photogrammetric block tend to have overlaps, meaning that a strip image also 

has a certain overlap with images from earlier and later strips. 

2.6. PHOTOGRAMMETRIC FLIGHT AND CAMERA REPORT 

When a photogrammetric flight is made, a report is created which reflects the flight 

characteristics (type, area, measures employed, flight data, images etc.) which accompanies 

the camera calibration report. In both reports there are a large amount of the parameters 

required for image orientation. 

2.7. PHOTOGRAMMETRIC PROJECT 

The photogrammetric project now needs to be defined, as a set made up of the concepts 

shown earlier, in other words: 

 A set of oriented images. 

 The models and strips that make up the images. 

 Camera and flight parameters. 
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3. USER INTERFACES 

Here we shall explain the operation of the program based on the user interface. This will allow 

us to show what can be done and how to do it at the same time.  

In order to access the application's main functions and characteristics, we will be using the 

menu bar or the main toolbar which can be seen at the top of the program's main screen. 

 
Figure 4 – Main TcpStereo interface 

The status bar at the bottom of the screen will show various messages in order to reflect the 

current state of the program and the action being taken at any moment.  

You may close the application by closing this window, or through the menu bar via File > Exit.  
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Main toolbar  

The functions will be outlined in greater detail in the different parts of this section. To give you 

an idea, we will outline the buttons from left to right, making it easy to understand what function 

each is responsible for. 

 Open project  Shows the selection dialogue of the project in order to open it. 

 Close project  Closes the project that you have open. 

 Project properties  Shows the properties of the current project. 

 Camera properties  Shows the properties of the project camera. 

 Show image  Shows the current image. 

 Show stereo  Shows the current model. 

 Show block  Shows the project block. 

 CAD  Connects to the CAD you have set up (see Customization). 
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3.1. PROJECT 

A TcpStereo project is really a structured set of data and image files, allowing the user to 

view images, models and the block from a photogrammetric flight, as well as the parameters 

used to show these elements. The hierarchical structure of folders and files used by a project 

is as follows: 

 
Figure 5 – Project file structure. 

The project can be seen as a single document, which can be created and consulted through 

the TcpStereo program. TcpStereo does not eliminate or alter any files from the project 

folders, as this might produce errors and even make it impossible to open the project. 

3.1.1. OPENING AND CLOSING 

In order to open a project, use the menu bar via the following sequence Archive > Open 

project… or via Open project from the main tool bar. 

A dialog box “Select Project File” will open, inviting you to open the project folder and select 

the project file (.pry) you wish to open. 
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Figure 6 – Project selection dialog. 

Once the project file has been selected, TcpStereo will load the project and show a view of 

the block. 

 
Figure 7 – Loaded project. 

The project can be closed using the menu bar via the sequence: File > Close or via Close 

project from the main tool bar. 
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3.1.2. IMPORT 

TcpStereo can import projects from a number of other sources: 

 From the data from digital photogrammetric flights with inertial sensors. 

 From a subset of project files oriented in Digi3D. 

In both cases the essential information is the same. 

 Photograph image files. 

 Flight parameters. 

 Camera parameters. 

 Internal and external orientation parameters. 

 

Import project from a digital photogrammetric flight 

Use the import option when you have digital images created by a digital photogrammetric 

camera and an external orientation file generated by the inertial sensors in the plane. 

In order to import this kind of project, use the bar, entering File > Import project > From 

flight data… An “Import digital flight project” dialog box will appear, as can be seen in 

Figure 8. 

 
Figure 8 – Project selection dialog. 

You will firstly need to indicate the location of the entry data, that is to say, the file that 

contains external orientations, and in what folder the image file can be found. All the images 

must be in the same folder. 
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You should also decide what name to give the project and in which folder the information 

obtained will be saved (ensuring that it has sufficient space). 

Finally, you have the option to carry out the import in two different ways: 

 Creating reduced pyramid images: 

Allows the import to be made in less time, although images will initially be of lower 

resolution. 

 Creating complete pyramid images: 

Created during the import of pyramid images at the maximum resolution possible. 

If you are not sure you need all the project images, or there is a large number of them, it is 

preferable to import in reduced mode. For less images the full mode import does not usually 

take more than a few minutes. Bear in mind that you can a reduced project into a complete 

one by using the tool “Generate pyramids” which is fully explained in the corresponding 

section. 

Once the required information has been supplied, click Next to continue the import. The 

dialog will update, now showing the information regarding external orientations found in the 

file you specify and in the form they are to be interpreted. 

 
Figure 9 – Import dialog: External orientations. 

Note: Throughout the import process the user will be kept informed of partial results, 

warnings and errors that might occur, via the table at the bottom of the dialog under the title 

“Import events”.  

The content of the table represents the information read in the external orientations file and 

interpreted in line with that established in this dialog. By choosing from the options from the 
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Separator drop-down menu, you can indicate what separator should be used to identify the 

various fields in the external orientations file. Similarly, if the column headers do not 

correspond to the content, use the tabs at the top of the table to assign them correctly. It is 

important that the Angles drop-down menu represents the angle units used in the columns 

represented by the rotations Omega (Ω), Phi (Φ) and Kappa (Κ). 

The first column in the table indicates which external orientations are to be imported initially, 

although subsequently they may not be able to be imported for various circumstances. You 

may select or deselect all the lines using the tabs provided. Bear in mind at least two 

consecutive external orientations need to be imported within a strip in order to create a 

stereoscopic model. 

Note: Throughout the import process, you may go back to the previous strip by clicking on 

“Previous” or by cancelling the process by clicking “Cancel”.  

Once all drop-down values have been correctly set, click Next to continue the import. The 

dialogue will update again, now showing the information relating to images found in the file 

you specify. 

 
Figure 10 – Import dialog: Images. 

A list of images of those that appear in the image file will be shown, enabling the 

corresponding external orientation to be imported. If an image which is not on this list is 

detected, check that its external orientation has been selected and that the image is 

contained in the correct image file. 

In the same way as in the previous step, you may select/deselect all the images, or 

individually check or uncheck the corresponding box in the table. You should consider two 

questions here: 
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 That you have selected at least two consecutive images with the same strip, in order to 

generate at least one stereoscopic model. 

 That in the information referring to disc space, the Available space value should be 

greater than the Required space value, in order to create the project. 

Note: If the project is imported using the reduced mode, the required space is far less than 

is needed to import in full mode. If there is the possibility that a large part of the project will 

later be converted to full mode, take the precaution of ensuring that the project's destination 

folder in on a disk with sufficient free space. Nevertheless, there is always the option of 

moving the project to another disc with more free space without loss of information. 

When you have selected the images that you want to import, click Next. Once again, the 

dialog will update, this time showing the stereoscopic models that can be created. 

 
Figure 11 – Import dialog: Models. 

You now need to select what models you wish to generate in the import. The logical thing to 

do is to select them all, as these are the models that can be formed with the orientations 

and images selected in earlier strips, the amount of information produced is not great and 

the processing time is insignificant. Having selected the necessary models, click Next. You 

will now be able to see the relation between the camera and flight parameters. If the 

process has been correct, you will only need to indicate the average height of the terrain in 

order to correctly represent the photogrammetric block and stereoscopic models. 
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Figure 12 – Import dialog: Parameters. 

Note: You can check camera values with those shown in the camera calibration report, and 

see how “Focal distance” and “Dimensions” cannot be zero. The average flight height 

shown is that calculated based on external orientations of the selected images. The 

average terrain height should be entered by the user (at least approximate).  

After checking and confirming parameters, click Next to start the conversion of original 

images into pyramids and end the import process. You can now see how the dialog 

changes content, in order to show conversion progress. Three progress bars will appear, 

corresponding to the conversion progress of the current image, of the current  strip and of 

the project as a whole (all strips). 

Note: TcpStereo will create strips based on the external orientations, images and models 

that you import. Strips correspond to images which are consecutive in terms of number and 

external orientation (photo-center and rotations). 
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Figure 13 – Import dialog: Conversion. 

In the dialog you will also see two tabs which show conversion time and estimated total 

time. Given the computing cost involved in creating pyramid images it is normal that the 

time taken bar does not update in real time, although it will update every few seconds. The 

situation with the progress bars is similar. 

Once all images have been converted, the project will have been created and you can click 

End, concluding the import process and closing the dialog. 

Import a Pix4d project 

TcpStereo offers this option to import camera data, exterior orientations and images from a 

Pix4d project. 

In order to import this kind of project, use the menu bar with the sequence File > Import 

project > From Pix4d data… A folder selection dialog will appear, where you should select 

the folder of the Pix4d project to import. 
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Figure 14 – Folder selection dialog 

Once you have selected the required folder, the dialog “Import data from Pix4d” will be 

shown, with several fields filled automatically. Check these fields to ensure that the files and 

folders are ok, and set the flight and ground average heights, and the output data options to 

your preferences, as we did in the digital photogrammetric flight. 
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Figure 15 – Import Pix4d data: Files and Folders 

Click “Next” to advance to “Camera and Photos” tab, where you can edit the camera 

parameters and select/unselect the images to import. Do not forget to specify the used 

angle unit. In the bottom of this dialog you will see info, warning and error messages 

relatives to the import process and events. 
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Figure 16 – Import Pix4d data: Camera and Photos 

Clicking the “Next” button the “Strips and Models” tab is shown. In the tree of the left side 

you can check/uncheck the strips and photos you wish import, while in the list on the right 

side you can check/uncheck the models that will be created based on the strips and photos 

checked before. 
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Figure 17 – Import Pix4d data: Strips and Models 

Watch that button “Next” changes its text to “Process”. If you are sure that everything is ok, 

click that button to start the conversion process. 
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Figure 18 – Import Pix4d data: Conversion 

The process will create the pyramidal images from the undistorted images of the Pix4d 

project, showing the progress for each image and strip as well as the global progress. 
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Once the conversion has finished, click on the “OK” button and the project block of images 

just imported will be shown. 

 

 
Figure 19 – Import Pix4d data: Block of images 

Import a Digi3D project 

Use this import option when you have a Digi3D project and external orientation file based 

on this project and created by Digi3D, or else by a set of files which contains the external 

orientation of one of the images. 

In order to import this kind of project, use the menu bar, entering File > Import project > 

From DIGI3D… A dialog box will appear, “Import Digi3D project”, as can be seen in Figure 

20.  
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Figure 20 – Import Digi3D project dialog. 

Firstly, you will need to indicate how external orientations are to be supplied: 

a) In a single external orientation file. 

b) In various files, one for each image considered. 

You should also indicate if the images are analog or digital photographs. Once this has 

been done, you need to specify the location of data entry - in other words the file or folder 

that contains the external orientations, the location of the Digi format(*.in) internal 

orientation files, in what folder the image files can be found and which file contains the Digi 

format camera (*.cam). 

As was the case when importing digital flight projects, you should also decide what name to 

give the project and in which folder the information obtained will be saved (ensuring that it 

has sufficient space). 

When importing Digi3D projects complete pyramid must always be created. 

Note: When importing both digital flight projects and Digi projects using the full mode, a 

dialog box will appear: “Use existing pyramid images”. If you check this box and the folder 

“Images” folder for the project already exists and contains pyramid images (*.mpt) which 

coincide with those you wish to import, they will be taken from the folder, without the need 

to create them again. 

Once the required information has been supplied, click Next to continue the import. From 

here on, the steps are exactly the same as those explained in the flight data project import 

section. It is important to confirm that the parameters before conversion are correct, and 

establish the average height of the nearest terrain. 
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3.1.3. REDUCED AND FULL MODES 

Projects imported from digital flight data in reduced mode can be shown in two ways, in 

reduced mode with reduced images or in full mode, with images from which pyramids can 

be generated. In order to change from one mode to the other, use the tab Reduced 

mode/Full mode on the right of the tool bar. 

When you change from reduced mode to full mode, a dialog box will appear to remind you 

that there are still images which may be converted into complete pyramids, giving you the 

option to convert it at that moment. 

 
Figure 21 – Full mode dialog box. 

You can also create complete pyramids via the main menu - Tools > Create pyramids. 

There is further information on this matter in the corresponding section. 

Once pyramids have been created from all the images in a project initially imported as 

reduced, the project will always be shown in the full mode, and the change mode option will 

no longer appear in the main tool bar. 
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3.1.4. PROPERTIES 

The properties of a project that is currently open in TcpStereo can be easily checked, using 

the menu bar - File > Properties… 

 
Figure 22 – Project properties. 

This shows information relating to the project (non-editable), as well as data provided by the 

program, which has no bearing on application operations. Via the tab Properties… in the 

box Flight information you can access the parameters of the camera used in the project. 

You can also access project properties via the tab Project properties from the main tool 

bar. Camera properties are also directly accessible via the tab Camera properties on the 

main tool bar. 
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Figure 23 – Camera properties. 

Camera properties are also editable, and reflect the parameters obtained during the project 

creation process (import). Among other aspects it shows if the camera is analog or digital, 

the Focal distance values, Image dimensions (format), fiducial coordinates and the center. 

Note: The information shown in properties is only for consultation purposes - once a project 

has been created it cannot be modified. Certain information fields are included in order to 

provide compatibility for future development and application improvements. 
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3.1.5. STRIPS, MODELS AND IMAGES 

When you load a project, on the left-hand side of the screen there is a tab with the name of 

the current project. If you move the cursor over this tab you will see a strip and model 

control window. 

    
Figure 24 – Strip and model control window. 

Clicking on the “thumbtack” on the top bar allows you to set this window so that is no longer 

visible, or free it so that it is automatically hidden when the window is no longer active. If it 

is set, you can drag it by left clicking on the top bar, and either leave it as a floating window 

or anchor it to one of the margins of the program's main interface. In either case you may 

resize the frame by dragging its edges. 

In this window or control menu there are two tabs, one corresponding to strips, the other to 

models. As its name suggests Strips allows us to see how the project has organized the 

strips, with the images included in each strip, whilst the tab Models shows the project's 

models and the images it consists of. 

The image and model elements of this window can be selected by left clicking which brings 

up a series of options which can be chosen by right clicking. 

One of the options available is seeing the properties of the element in question. In the case 

of images, by right clicking on an image element and then selecting the option 

Properties…” you will see a dialog box that shows information regarding the image file, 

and its internal and external orientations. 
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Figure 25 – Image/photograph properties. 

Similarly, in the case of models, you can select Model properties…” 

 
Figure 26 – Model properties. 

In the case of models, the properties shown relate to the image files that make up the 

model, along with external orientations. You can also see information referring to the 

model's relative and absolute orientations. This information is not relevant to the user 

although it can be applied to future extensions to the software and its compatibility with 

other programs - it is therefore not necessary to explain its meaning here. 
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The selection of an image or model in the control window means that this element becomes 

the current image or model, the consequences will be seen in the next section dealing with 

visors. As a foretaste we can say that some menu bar and main tool bar options are based 

on the current element, which will be the object of the actions to be taken. 

Further information regarding external orientation of all project images can be found at 

View > External orientations from the main menu. 

 
Figure 27 – List of external orientations. 

Each row of the table shows the external orientation of an image. The first column 

corresponds to the image number. The three following fields show the photo center's X, Y 

and Z coordinates - the three last values correspond to the camera's omega, phi and kappa 

rotation angles. These should be angularly equal or equivalent to values read from the 

external orientation file/s of the specified images during project import. 

Via the Angle units drop down menu you can select on which units you wish the tables 

rotation angles to be shown. 

The strip control window can also be used to hide strips. This will have two consequences: 

the first is that hidden strips will not appear on the block viewer. The second is that on 

establishing automatic model change, only those models from non-hidden strips will be 

changed. This allows you to work with a subset of photogrammetric flight strips. 

3.1.6. CAD TOOL 

We are taking CAD tool to mean AutoCAD 2004 – 2016 and Bricscad v9 to v15 software 

which you will have installed on your computer and configured in TcpStereo as “CAD 

Version” (see Customization) - the CAD program you will be using to draw in from 

TcpStereo. Once you have opened the project and established a specific CAD program, 
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click CAD on the main tool bar in order to connect with the CAD application. If this program 

is already running, TcpStereo will automatically connect to it. If not, it will launch it and a 

few seconds later which are needed to start up the application, TcpStereo will connect to it. 

If there is any problem, the corresponding message will appear, or the program will not 

connect to the CAD. 

You need to have had the CAD program installed prior to installing TcpStereo to ensure a 

correct connection, given that the installation process sets up for the various CAD programs 

it detects in order to communicate with TcpStereo. 

On connecting to the CAD, you should see a CAD control window, as shown in Figure 28: 

 
Figure 28 – CAD control window. 

This window has three elements that control some aspects of the application: 

 Option Auto centered  CAD monitoring is always centered. 

 Tab Layers…  Shows the layer selection dialog to be shown in TcpStereo 

models. 

For a better understanding of this area, please see the section that refers to CAD toolbar on 

the model viewer.  

Note: When there is a communication problem between TcpStereo and the CAD 

application it connects to, the user will ne notified via a dialog box. Check that the CAD 

control window is visible and cancel any open command in the CAD program. 
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3.2. VIEWERS 

The term "viewers" refers to the three types of window that allow us to see project images in 

different ways: 

 Block viewer: All project images together. 

 Image viewer: Each project image in an individual manner. 

 Model viewer: Pairs of images that form models. 

Each viewer features one or more toolbars which allow us to undertake a series of actions in 

order to control the viewer or access an additional function. Interaction with all viewers is via 

your mouse and keyboard (See the section Customization to see how to set up the 

keyboard). 

3.2.1. BLOCK VIEWER 

The block viewer shows all project images, arranged as a mosaic and positioned depending 

on their respective external orientations and flight parameters. The block viewer appears 

immediately after opening or importing a project. 

 
Figure 29 – Open block viewer. 

This viewer can be closed by clicking on X in the top-right corner, and can be brought back 

via the menu bar - View > Block or via the tab Show block on the toolbar. 

Block viewer control using mouse and keyboard 
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The basic block viewer actions are: 

a) Offset: To offset the viewer, left click on viewer content and drag using the mouse. The 

viewer will move correspondingly. You may also offset the viewer by using the offset 

keys configured to this end (see the section Customization). 

b) Scale / zoom: You may increase and decrease scale and zoom by using the scroll 

wheel on the mouse, turning it back and forth. You may also use the zoom keys which 

have been set up for this. 

c) Selection: To select an image from the mosaic and bring it to the front, you just need to 

left click on the number of that image. The current image is profiled in red, whilst others 

are profiled in yellow. 

 

Note: See how on selecting an image in the block viewer, it is shown as selected in the 

strip and model control windows. Similarly, if another image is selected in the window, 

this will be shown as the current image in the block viewer, coming to the front. You can 

therefore order photos in the mosaic through the selection of the various images. 

 

Block viewer toolbar   

This consists of a set of tabs whose functions are, from left to right and separated by 

function, as follows: 

1) Display functions: 

 Zoom extension: sets the scale to the maximum possible value in order to show the 

whole block adjusted to viewer dimensions, varying the cursor position. 

 Zoom window: allows the user to select a rectangle within the current display enabling 

changes to scale and position in the selected area. 

 Zoom in: increases scale whilst maintaining position. 

 Zoom out: decreases scale whilst maintaining position. 

 Preview zoom: allows the user to return to earlier displays (scale and position) which 

change when any zoom operation is undertaken. 

 Drop down scale menu: shows the current scale at any point, allowing the user to 

select a predefined scale or assign an arbitrary scale via the keyboard. 

2) Image functions: 

 Copy to clipboard: saves the current display in the clipboard, allows you to cut and 

paste using any application capable of accessing the clipboard. 

 Save image: allows the user to save the current display in an image file, in BMP, JPG 

or TIF format. 

The block viewer features a status bar at the bottom of the viewer, showing the 

approximate planimetric coordinates which the cursor moves over. 

3.2.2. IMAGE VIEWER 

The image viewer always shows the current image. There are a number of different ways 

that you can open the image viewer in order to show a specific image: 

a) By selecting the image and clicking on View > Image on the menu bar. 
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b) By selecting the image and clicking on Show image on the toolbar 

c) In the control window, right click on the name of the image and selecting the option 

Show image. 

d) In the control window, double left click on the image name. 

 
Figure 30 – Open image viewer. 

Image viewer control using mouse and keyboard 

The image viewer is controlled in the same way as the block viewer, with two differences 

due to the fact it contains a single image: 

 They do not allow offsetting beyond the limits of the image. 

 There is no need for selection as there is only one image. 
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Image viewer toolbar    

The image viewer toolbar is the same as on the block viewer (the same tabs and functions), 

with the addition of a new tab View minimap”. 

 
Figure 31 – Viewer with minimap. 

The minimap is a small window that shows the same image shown by the viewer (in full 

form), allowing the user to rapidly establish viewer position on a specific area by left clicking 

on an section of the minimap. It also shows a rectangle that represents the area currently 

shown by the image viewer. 

The image viewer features a status bar at the bottom of the viewer, showing the pixel 

coordinates which the cursor moves over or is centered. 
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3.2.3. MODEL VIEWER 

The model viewer always shows the current model. There are a number of different ways 

that you can open the model viewer in order to show a specific model: 

a) By selecting the model and clicking on  View > Model on the menu bar. 

b) By selecting the model and clicking on Show model on the toolbar. 

c) In the control window, right click on the name of the image and selecting the option 

Show model. 

d) In the control window, double left click on the model name. 

 
Figure 32 – Open model viewer. 

Model viewer control using mouse and keyboard 

The model viewer is controlled in a similar way to block and image viewers, except in this 

case the models are shown in three dimensions. The scroll wheel on the mouse is therefore 

not used to control zoom/scale, but to control height and elevation (the Z axis value). This 

elevation value can also be controlled using the keyboard (see the Customization section). 

The model viewer has many more functions on its toolbar than the other viewers, meaning 

that there are a series of considerations regarding viewer control which will be explained in 

detail within each available function.  

 

Model viewer toolbar 
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The model viewer has up to four different toolbars, described below. It is important to 

understand the role of each toolbar, as their correct use allows you to get the most from the 

program. 

a) Scale/zoom control bar:   

Covers the zoom functions and saves images displayed earlier: 

 Extension zoom  View the whole model. 

 Window zoom  View a selected part of the model. 

 Zoom in  Move in, increase zoom. 

 Zoom out  Move out, reduce zoom. 

 Previous zoom  Return to the previous position and scale. 

 Exact zoom  Establishes a specific zoom factor. 

 Copy to clipboard  saves the current display on the clipboard. 

 Save image  Saves the current display as an image file. 

 

b) Stereo control bar:   

This toolbar allows the user to control the way in which the stereo viewer is displayed. 

From left to right, this allows the user to: 

 Show/hide the left-hand image. 

 Show/hide the right-hand image. 

 Rotate the model 180º  Invert the display. 

 Invert/swap eyes  Swaps the image seen by each eye. 

 Enable/disable stereo: two ways to show the model. 

Pseudo-stereo  Both images are seen by both eyes, translucently. By using this 

option it is possible to see the image in stereo, via anaglyphs. 

Real stereo  Shows an image for each eye, for the rest of the stereo vision 

systems. 

 Automatic Snap  Using cross correlation, the application tries to set the cursor 

height at ground level. 

 

c) Geometric function toolbar:   

The geometric function toolbar offers three tools which, from left to right, permit the 

following: 

 Situate the display on specific XYZ coordinates. 

By clicking on the corresponding tab, a floating window will appear - Terrain 

coordinates, which allows you to set the exact coordinates. 

You can enter a value for each coordinate and click on Situate so that the model viewer 

situates in this position, or else enter one of the values and click Enter. 
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Figure 33 – terrain coordinate window (XYZ). 

 Measure 2D and 3D distances. 

By clicking on the corresponding image, the model viewer enters into a special control 

mode which we shall call “Blocked mode”. In this state, the central viewer cursor 

moves as you move the mouse, without having to click on the mouse. The left mouse 

button is now used to designate points on the model, which correspond to the vertices 

that define the polyline segments from which the length will be calculated. Once all 

the required points have been thus marked, right click to finish. 

Note: The status bar at the bottom of the model viewer shows both the current terrain 

coordinates and the results of certain operations. You will see that when using the distance 

or area measurement tools, this bar will show the results from these measurements. On the 

right of the bar it shows a series of values that refer to the Z increase. These values refer to 

the extent to which the elevation varies each time that the user moves the scroll wheel. 

Refer to the Customization section for more information on this matter.  

 Measure 2D and 3D perimeter and area. 

On clicking on the corresponding tab, the view finder enters into “Blocked mode”, and, 

as in the case of the previous tool, you can designate points by using the left mouse 

button and conclude the operation with the right mouse button. 

 
Figure 34 – Model viewer, area measurement tool. 

The “Measure distance” and “Measure area” tools work in a similar way, with the latter 

being an extension of the former in the sense that it calculates the distance which 
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corresponds to the length of the closed polyline, as well as calculating the 2D surface area 

contained in each polyline.  

d) CAD function toolbar:  

This final toolbar is possibly the most powerful, as it allows the model viewer to 

communicate with the external CAD program to which TcpStereo is connected. The toolbar 

is not visible in the viewer until TcpStereo successfully connect to the CAD application 

entered at set up. 

The following are the functions and information which feature on the toolbar, from left to 

right, as with earlier toolbars, here grouped together based on function: 

Representation functions: 

 Synchronize CAD  Allows the rest of the CAD toolbar functions to be 

enabled/disabled. Among other things, ensure that movements within the model viewer 

also apply to the CAD program. 

 CAD rotation  Ensures that the display in CAD has the same orientation as that 

appearing in the model viewer. 

 Show CAD  Allows the selected, active layers from the current CAD illustration to be 

displayed in the model viewer, superimposed on the images. 

 Refresh CAD  Refreshes the model viewer display, reloading the layers to be shown. 

In order to select illustration layers, click on Layers… in the CAD control window (Figure 

28) 

Illustration functions: allows the model viewer to strip to “Blocked mode”. The left and right 

mouse buttons allow you to control the illustration on starting up any of these functions, 

along with the keys assigned during program customization. 

 Draw Points: Move the mouse and the scroll wheel in order to situate the cursor in the 

position where you wish to place the point. Left clicking confirms the designation of the 

point. You may designate as many points as you wish. Left click to finish the operation. 

 

 Plotting 2D contours: On starting up this operation from the CAD toolbar on the model 

viewer, the 2D curve parameter window will appear. This window allows you to set 

parameters which define operation performance in terms of two aspects: 

 

1 - Registry: Establishes how many points are to be eliminated on each sweep (using the 

configured delete key) and the registry distance, the distance from the last point of 

the cursor position, automatically added as a new point.  

2 - Elevation variation: Allows you to draw a 2D curve and, when finished, the model 

viewer to situate the display at the start point, although with the elevation difference 

due to the “Elevation variation” value in the indicated direction. 
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Figure 35 – 2D curve function parameters. 

Once the parameters have been set, you may move the mouse and the scroll wheel in 

order to situate the cursor in the position where you wish the curve to start. Bear in mind 

that once started, the elevation cannot be changed (the scroll wheel and keys assigned 

to change the elevation will have no effect). 

In this case, left clicking will start, detain and continue the plotting of the curve. If the 

illustration is active, on moving the cursor points will be added. If the plotting of the 

illustration has been detained and you continue it, points will be inserted from the last 

plotted point to the current cursor position, based on the distance from the current 

registry. 

 

 
Figure 36 – Plotting 2D contours. 

If you right click, regardless of whether the illustration is active or not, points will be 

inserted from the last plotted point to the current cursor position, finishing the curve, but 

maintaining the command, meaning that a new curve can be initiated at the same 

elevation. If you right click again, the 2D curve plotting command is closed and the 

viewer returned to its initial plotting position, with the elevation resulting from the 

application of the “Elevation variation” parameters. 
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Note: When the viewer is not in Blocked Mode, right clicking will repeat the final plotting 

operation (point, 2D curve, incline or 3D polyline) undertaken, without the need to 

establish parameters, should they be required. 

2D contours are perfect for plotting contours, and are also suitable for representing the 

edges of flat surfaces. 

 

 Plotting slanted lines: On starting up this operation from the CAD toolbar on the model 

viewer, the incline parameter window will appear. This is done in a similar way to the 

plotting of 2D contours, although only registry parameters can be set, given that in this 

case, the elevation can be modified, meaning that automatic control of the position 

based on the elevation is not necessary. 

 
Figure 37 – Incline function parameters. 

In order to plot slanted lines, the functions of the two mouse buttons varies slightly, as 

follows: 

- The left button is used to start or continue the plotting of the incline. If it is already 

plotted, left clicking registers the current elevation for subsequent interpolation. 

- Right clicking detains plotting, if this is in progress. If the plotting has already been 

detained, it finalizes the operation. 

 

The incline plotting tool features two types of interpolation: 

- An interpolation in XY, based on registry distance, in exactly the same way as when 

plotting 2D contours. 

- Another interpolation in Z (elevation), where at each intermediate point between 

marked points (designation of the current elevation) an elevation value is assigned 

between the height of the first and second registered points, based on its position 

within the polyline defined by the registry points. 

 

 Plotting a 3D polyline: This plotting function also allows a 3D polyline to be created, with 

the left mouse button used to designate the vertices of the polyline. Right clicking 

finishes the polyline. 
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Figure 38 – Plotting 3D lines. 

Very important – Specific keys 

In the Customization section, there is a paragraph which refers to specific model viewer 

keys. A specific set of keys designated for stereo plotting. Ensure you have set up and 

remember these designations, as they allow greater control over plotting, with the 

following options: 

1) “Finish plot” key: Immediately finishes the current plot. 

2) “Close plot” key: Closes the current plot. 

3) "Delete points” key: Deletes one or more points from the plot. 

4) "See last point” key: Positions the viewer from the last plotted point. 

5) “Next point” key: Situates the cursor on the vertex coordinates closest to the present 

plot on the active layer, excluding the current plot, and designates a new vertex to 

these coordinates. 

 

Additional functions: 

 Undo: Once a plot has been finished, this tab allows a number of vertices to be deleted 

from this polyline. 

 Active layer: This is not really a function, instead it shows the name of the layer of the 

plot in the CAD application that is currently used as the active layer. 
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Very important – Layer selection 

The active layer will be set on the CAD application. 

The visible layers will be those which are designated in layer selection dialog box which 

appears when you click on Layers… in the CAD control window (Figure 28). 

 
Figure 39 – Layer selection dialog box. 

This is a very intuitive dialog, where on the left-hand side the available layers appear in the 

CAD illustration, whilst on the right side the layers are shown on the stereo in the model 

viewer. You can move layers from left to right using the tabs that separate both lists. 

Note: On connecting TcpStereo to the CAD program, and setting up a model viewer to 

display CAD layers, the layer selection dialog will automatically appear. If it is not visible the 

TcpStereo window might be hiding it. Click on the CAD program, making it the active 

application, to make the layer selection dialog come to the forefront.  
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3.2.4. MULTIPLE VIEWERS MANAGEMENT 

When you have a number of viewers open at the same time, these are organized into tabs, 

meaning that each is accessible by clicking on the title. 

As has been mentioned earlier, the strip and model control windows (Figure 24) are initially 

automatically hidden, and can be set and anchored to the edges of the main window. It can 

also be left as a floating window, allowing you to move and resize it as you wish. 

Something similar can be done with the viewers, with it possible to view various at one time, 

in differing formats and sizes. 

 
Figure 40 – Multiple views with different viewers. 

In order to achieve this, double click on any anchored viewer or drag it (left click and move 

the mouse), making it a floating window. If you double click on the title bar of the floating 

window, it will return to its fixed position, or you can drag it and set it in a new position. You 

can also anchor floating windows within other fixed or floating windows. 

If the Automatic model change option is activated during set-up, it is recommendable to 

have a single model viewer open, as when moving within a model you might find yourself 

with the same model open in two viewers. 
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3.3. TOOLS 

This sub-menu within the main menu gives you access to TcpStereo's customization options 

and the creation of complete pyramid images (maximum resolution). 

3.3.1. SET UP 

See the Customization section. 

3.3.2. GENERATION OF PYRAMID IMAGES 

As mentioned during digital flight project import, it is possible to carry out a reduced import 

which allows you to complete the import in less time, resulting in images with a lower 

resolution than the originals. The creation of pyramid images allows you to generate images 

which are visible in full mode. To do so you will need to have the original images. In order to 

start the pyramid image generation process, via the main menu run the sequence Tools > 

Create pyramids. A dialog box will appear enabling the generation of complete pyramid 

images, described below: 

 
Figure 41 – Pyramid image generation dialog box. 

In the table a list will appear with the images that make up the project. You can select the 

images to be converted by checking/unchecking the boxes on the left and using the buttons 

Select all and Deselect all. On the right you will see a preview of the image corresponding 

to the selected line. The lower part shows information concerning available disc space 

required by the generation of pyramids. If the line corresponding to an image has a grey 

background, it means that the image in question has been converted into a pyramid image, 

thus blocking it from being generated again. 

At the bottom of the dialog box a progress bar will appear with text giving information as to 

the current situation or the result of the conversion operation. 

Once a set of images has been selected, clicking on Generate will launch a process that 

will create a pyramid image from each selected image. This process can be cancelled, 

although you should allow the current image conversion to finish. 



TcpStereo                                                                                            Reference Manual 

 

 Aplitop S.L. 2015      45 
 

 
Figure 42 – Generating a pyramidal image. 

Once the process has finished, the table is updated to reflect the new status. The pyramid 

image generation dialog box can now be closed or else you can continue to select and 

create pyramid images. 

 
Figure 43 – Result of the pyramid image generation. 

Note: If no pyramid image is generated from a project imported in reduced mode, when 

striping to full mode, it is normal and logical that no element appears in the image and 

model control window. 

3.4. HELP 

Through this option from the main menu you can access reference manual, as well as the 

program information dialog box. 

 
Figure 44 – The "About TcpStereo" dialog box 
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4. CUSTOMIZATION  

A number of program aspects can be customized, and certain function parameters can be 

established. In order to do so, go to Tools > Set up. A window will appear showing a series of 

tabs, the content and meaning of which is explained in the following sub-sections. 

4.1. GENERAL 

In the “General tab three groups appear. The first of these Language allows you to select 

the language you wish the function to appear in. The languages currently available are 

Spanish and English. If you decide to change language, the application will restart in the 

selected language. 

 
Figure 45 – General set up. 

In the second group - Stereo viewer there is a drop down control menu showing the different 

CAD versions which are compatible with TcpStereo installed on the computer. The selected 

version is the one that TcpStereo will connect to. There is also a checkable box that allows 

you to indicate if the model will change automatically as the user moves over them or if the 

model change has to be made manually. 

Finally, the group Use of memory shows information as to the current state of the physical 

memory installed on the system. The slider control establishes a maximum value for 

occupied memory, from which point the program will not allow more image or model viewers 

to be opened. It is recommended that this limit be set as high as possible in order to prevent 

the blocking of new viewers. 
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4.2. KEYBOARD 

There are two tabs Keyboard (1) and Keyboard (2) which facilitate the set up of the keypad 

for interaction with the various viewers. In order to assign a key to a function, use the mouse 

to select box associated to the function, then click the key you wish to assign to the function 

in question. Bear in mind that certain “special keys” cannot have a function assigned to them 

(Escape, Intro, etc.) whilst assigning keys already used to a new function will mean that that 

function has no assigned key. 

The tab Keyboard (1) features a group Movement and Scale, which covers the keys used 

to move on the X and Y axes, and to control the various zoom functions on the toolbars 

(common to all) for all viewers via the keypad. 

 
Figure 46 – Keypad (1) set up. 

The tab Keyboard (2) is specific to the model viewers and is structured into three groups: 

 The Height variation group 

This establishes which keys allow variations to be made to the elevation (Z) as well as 

speed and the variation factor. 

 The Stereo vision group 

This is used to associate keys to various specific stereo viewer functions, which 

correspond to those on the stereo model viewer toolbar. 

 The Stereo drawing group 

This final group assigns keys to special function that can be carried out whilst plotting a 

CAD drawing from a model viewer.  
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Figure 47 – Keypad (2) set up. 

The meaning of the various keypad functions is explained in the Viewers section, with each 

detailed in the applicable section. 

We recommend that the user assigns keys in an easy to remember form and that their 

distribution is comfortable to use, bearing in mind you will be keying them frequently. 
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4.3. SPEED 

This tab determines the speed that the display moves on the X and Y axes when using the 

different viewers. It also specifies the speed at which the elevation (Z axis) can vary in stereo 

viewers, and the manner in which it does so. Finally, the speed at which the zoom varies is 

indicated, in a similar way to the speed in which the elevation can alter. Adjust all these 

values in such a way that movement and scale is most comfortable for you. 

 
Figure 48 – Speed set up. 

Displacement in X and Y is done on an image pixel level, whilst displacement in Z is done 

using terrain coordinates (meters). 

In the case of Z displacement, you can set both the amount of variation and the units by 

which it varies, from a centimeter to ten meters. 

The checked boxes can be linked to Z displacements and the variation in scale to the scale 

currently present in the viewer, ensuring that the variations of these values are proportional. 
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4.4. CURSOR 

The cursor is visible both in the block and the model viewer. The second may feature a text 

which shows the current elevation. It appears in the frame with a dark grey background. 

In order to personalize the cursor in both viewers, use this set up tab. Via the Cursor shape 

drop down menu you can change its appearance, selecting from Crosshairs, Cross and 

Point. You can also add a circumference to the cursor. In the lower part there is a control 

feature which changes the size of cursor, as well as a tab to set its color. 

In the case of model viewers, you can choose whether or not the elevation appears 

alongside the cursor, and if so, the font style, size and color, as well as the position of the 

text with respect to the cursor. Use the arrowed tabs to move the text, and the central tab to 

return to the initial position. 

 
Figure 49 – Cursor set up. 

Note: In order to move the text more quickly, click on the arrow that corresponds to the direction 

you wish, and set it by clicking on Intro. The text will continuously move in this direction until you 

release the key. 
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4.5. CAD DRAWING 

The CAD Drawing tab allows the user to set the way in which plot drawings are shown in the 

stereo viewer, when this is connected to a CAD application. Specifically, you can set: 

 The color and thickness of the plot in the stereo viewer. 

 The color and thickness of the plot in the active layer. 

 The color and thickness of the plot in the visible layers, designated in the layer selection 

dialog box (Figure 39) 

 
Figure 50 – CAD edition set up. 

If the boxes in the Customize the current layer and Customize visible layers groups are 

checked, the color and thickness established for each tab. If not, the color and thickness will 

be those used in the loaded CAD plot for each layer. 
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4.6. COLOR (PSEUDO-STEREO) 

The Color tab allows the user to set the color filter for the left and right images for each 

model, which will be applied when setting the model viewer to Pseudo stereo mode. To this 

end, two sets of slider bars are displayed, showing red, green and blue, associated to the 

images of a given pair. Additionally a series of buttons are available which allow you to 

establish a color set up for each image in a pair, meaning that the image can be 

anaglyphically viewed in stereo. The last tab in this series establishes a color balanced set 

up (non-stereo) which allows both images to be viewed in color. 

 
Figure 51 – Color component set up. 

  



TcpStereo                                                                                            Reference Manual 

 

 Aplitop S.L. 2015      53 
 

5. ACKNOWLEDGEMENTS 

In the development of the application we have been lucky to have the valued advice of José 

Luis Lerma García, Doctor in Geodesy and Cartography, professor of photogrammetry at the 

DICGF of the UPV (Universidad Politécnica de Valencia, Spain), affiliated to the ETSICGT. 

In preparing this manual and the examples included with the program we have made use of two 

flight projects, one digital, the other analogical. We would like to take this opportunity to thank 

the following for the providing of flight images and data: 

 SPASA, Estudios Politécnicos Aéreos, S.A., owner of the Brunete Project, Madrid. 

 TDT_SL Patrimonio Histórico, Técnicas Documentales Terrestres owner of the images 

from Chanza, Huelva. 

 

 


